(_| amplify care

Palliative Care Tool
User Guide V1.2

The Palliative Care Toolbar supports clinicians in earlier identification
of patients with a life-limiting illness who could benefit from a
palliative care approach
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Intended Tool Use

The Palliative Care Toolbar supports clinicians in earlier identification of patients with a life-limiting
illness who could benefit from a palliative care approach. This tool can provide decision support
in assessing the palliative needs of the patient and is then provided with the appropriate
resources, relative to the patient’s current Palliative Performance Scale (PPS) phase. The tool is
also equipped with Advance Care Planning tools that allow clinicians to customize a
reassessment date to prompt the Palliative Care tool to be used again.

Important note: this tool was originally created by the eHealth Centre of Excellence, which
rebranded to Amplify Care in 2025.
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1. Version History

Version Release Date

Updates

P
°
°
September ¢
12 2025
[ )
1.0 2018

Palliative Care Tool User Guide

Search criteria now looks at history of past health in the CPP
Resources have been updated/refreshed

Hidden resource library to customize with pre-configured
resources now included

Ability to update/customize resource list remains

Resources organized by patient-facing, clinician facing and
regionally-specific resources

Updated with collaboration from representatives from the
Ontario Palliative Care Clinical Coaches and colleagues
working on the Palliative Model of Care for Adults in the
Community, and Hospice Waterloo Region.

Originally created from a partnership between representatives
from the Waterloo Wellington Integrated Hospice Palliative Care
Regional Program and Amplify Care (formerly known as The
eHealth Centre of Excellence)
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2. Toolkit Contents

The palliative care toolkit includes:

Custom forms Reminders and Searches

Advance Care Planning Template.cfm
Palliative - Criteria Match.cfm

Palliative - BPl.cfm

Palliative - General Indicators.cfm
Palliative - Main Form.cfm

Palliative - CHF Indicators.cfm
Palliative - CKD Indicators.cfm
Palliative - MRC Indicators.cfm
Palliative - Office Visits Reference.cfm
Palliative - PHQ9.cfm

Palliative - Reassess.cfm

Palliative - SOAP.cfm

Palliative - Special Premium Bonus.cfm
Palliative - Specific Indicators
Reference.cfm

Palliative - Specific Indicators.cfm
Palliative - Toolbar.cfm

Palliative Performance Scale.cfm
Substitute Decision Maker - SDM.cfm
Symptom Response Kit Order Form.cfm
Palliative - ESAS-R.cfm

Palliative - PPS Instructions.cfm
Palliative - General indicators reference.cfm
Amplify-FeedbackForm.cfm
Amplify-InitialTermsForm.cfm
Amplify-MainForm-OptedIn.cfm
Amplify-MainForm-OptedOut.cfm
Amplify-NewVersionForm.cfm

o Palliative Toolbar Reminder.srx

o Palliative - All Flagged Patients.srx
o Palliative - Identified Patients.srx

e Palliative-Criteria-Age.srx

e Palliative-Criteria-ALS.srx

e Palliative-Criteria-ALS-HPH.srx

o Palliative-Criteria-Cancer.srx

e Palliative-Criteria-Cancer-HPH.srx
e Palliative-Criteria-CHF .srx

e Palliative-Criteria-CHF-HPH.srx

e Palliative-Criteria-CKD.srx

e Palliative-Criteria-CKD-HPH.srx

e Palliative-Criteria-COPD.srx

e Palliative-Criteria-COPD-HPH.srx
e Palliative-Criteria-Dementia.srx

e Palliative-Criteria-Dementia-HPH.srx
o Palliative-Criteria-Dyspagia.srx

o Palliative-Criteria-Dyspagia-HPH.srx
o Palliative-Criteria-Frailty.srx

o Palliative-Criteria-Frailty-HPH.srx
o Palliative-Criteria-LiverDisease.srx

o Palliative-Criteria-LiverDisease-HPH.srx

e Palliative-Criteria-MS.srx

o Palliative-Criteria-MS-HPH.srx

o Palliative-Criteria-NYHA3o0r4.srx

e Palliative-Criteria-Palliative.srx

e Palliative-Criteria-Palliative-HPH.srx
e Palliative-Criteria-Parkinsons.srx

e Palliative-Criteria-Parkinsons-HPH.sr

Handouts
o Palliativecarebillingguide.pdf e 7 Things to know about palliative care
e DNRC Information Bulletin e 10 myths about palliative care
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Resource Library handouts

Install these handouts if you’'d like to use the optional resource library to include them in your
tool. You can preview them by opening the files found in the zipped toolkit folder.

Users can also add their own resources (websites, custom forms and handouts) using
the built-in instructions shown when opening the main form in editor mode. *Note you
may need a custom form license*

e Hospice Room pamphlet

e maid-individuals-and-families

e MEDICAL ASSISTANCE IN DYING (MAID)
e ontario caregiver starter kit

e serious illness conversation guide

e SPIRITUAL ASSESSMENT TOOL- FICA

Installation

Installation process

1. Select the Palliative Toolkit zip file attachment and save it to your desktop or another file
folder location of your preference.

g Palliative Toolkit v1.0.0.zip @ save Attachment X
. 14 MEB « « 4 [& > ThisPC » Documents ~ © | Search Documents »p
Preview Organize = New folder = -
~ Name - Date modified Type Size
= Open ~ 3 Quick access
ick Pri Desktop  # Axure 2018-10-09 8:30 A File folder
=
@ Quick Print oo Custom Office Templates 2018-09-04 11:10...  File folder
& Downloaads
A Fax 2018-08-30 1:49 PM File folder
7 Saveds -
Ala CrziEE - My Received Files 20181123 1140...  File folder
Cha |r[?-,'] Save All Attachments... Pallistive A € My Timelines 2018-11-22 10:53 .. File folder
The ¢ Upload N = Pictures A4 Office Timeline 2018-09-28 2:11PM  File folder
oa
& =P Examples of Tc OneNote Notebooks 2018-09-10 2:43 PM  File folder
418 >< Remove Attachment low back pain Scanned Documents 2018-08-30 1:49 PM  File folder
Wa -
PDF
C:3 E@ Copy Tool JPEG
v £ >
We h
EW Select Al File name: | Palliative Toolkit v1.0.0 v
CONFIDENTIALITY NOTIGE: This email and attached mate: Save as type: | Compressed (zipped) Folder v
provisions of the Freedom of Information and Protection of P
operation and assistance. | MRS Tools + Cancel
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2. Extract and save the Palliative Toolkit zip file to your desktop or other file folder location
of preference. Right-click on the zip file and select Extract All... to save to the file

- Fax 2018-08-30 1:49PM  File folder
% Documents o
& My Received Files 2018-11-23 11:40 File folder
Palliative * @ MyTimelines 2018-11-221053...  File folder
& Pictures * Office Timeline 2018-09-28 211PM  File folder
Examples of Toolkit OneNote Notebooks 2018-09-10 243 PM  File folder
low back pain Scanned Documents 2018-08-30 1:49PM  File folder
oDE i Palliative Tod ji4PM  Compressed (zipy
o Open
Tool JPEG Open in new window
& OneDrive I Extract All...
= This PC S
@ Scan with Webroot
¥ Network @ share
Open with...
Give access to >
Restore previous versions
Send to >
Cut
Copy
Create shortcut
Delete
Rename
Properties

? Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder.

‘ C\Users\Test Patient\Documents\Palliative Toolkit v1.0.0

‘ Browse...

Show extracted files when complete

1.Importing Custom Forms and Encounter Assistants

1. Login to Practice Solutions and select the Records Tab

% PS5 Suite® EMR (TEST)

File Settings Reports Messages Window Help

Dr. Alan A Vong

Logout | Appointments | Patients Inpatients Clients | Address Book | Handouts Messages

>

Palliative Care Tool User Guide
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2. Inthe Records window, select the Settings tab -> Edit Custom Forms

-ile Edit Style Settings Patient View Data Letter
Edit Stamps...

55 King St. Edit Custom Forms...
Waterloo O
It Searches...
Edit Cohorts...
Edit Reminders... i
Palliative Edit Reminders of Demo Palliative
Mental Hea New Quick Individual Reminder for Demo Palliative...

New Alert for Demo Palliative... =

[ B Ed

"13ul 20, 201 )
Wt:155 Ik Q Decrease Text Size Ctrl+1

Q Increase Text Size Ctrl+1 —

3. Select the File tab -> Import Form(s)...

<% Forms >
File

New Custom Form... Ctrl+N

New Encounter Assistant... Ctrl+Shift+N ~

Edit Form Ctri+E

Create Encounter As...

Create Form

Edit Form
Rename Form Ctrl+R

Duplicate Form Ctrl+D Duplicate
Deactivate Form

Import Form(s)...
Export Form(s)...

Show Revision History.
Show Deactivated Forms...

Restore from Automatic Save

2013 CPX women ~
< > Done

3. Find the file location where you have saved the unzipped Palliative Toolkit files, select all
by “Ctrl + A” or “Apple button + A” so it automatically Select all. Click Choose.

% Choose Custom Form Filz s |

Lookin:  Custom Forms ~| el

=

|

g8
= b
Recent tems )

< >| B

File name: |scision Maker - SDM.cim" "Symptom Response Kit Drder Form.cfm” I Choose I
Files of type:  all Files v Cancel
T T ™
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4. To insert one of Palliative files into a patient’s chart/record (i.e. the Palliative — Main
Form):
a. Find the patient record in PSS

File Edit Style Settings Patient View Data Letter

# Palliative, Demo E& New Progress Note Ctrl+N

55 King St. ==
Waterloo ON  N2L 3K9 =) Meryleiae Sl

New Diagram... Ctrl+Shift+G
I g New Custom Form... Ctrl +Shift+| I
~Profle ew Report.. Ctrl+R
. ﬁ Absentee Note... Ctri+Alt+A
Palliative ol Pending Test or Consult.. Ctrl+K

Mental Health Diabetes

® Prescribe.. Cirl+B L
B EBEE a4 B O New Treatment... Cirl+)
(G 20, 2017 Perform Treatment... [

b. Select the Data tab -> New Custom Form...

c. Search for the custom form you would like to insert (i.e start typing keyword
Palliative — Main Form in the text field) and select it from the custom form list ->
Choose This Form.

% Select a Form X
Palliative Mal Palliative - Main Form

Fesources in RED = need to ensure linking properly to tool jpulling in recent date

Orange= missing resource from Excel spreadsheet

Green= Handout needs to sl be linked

= needs to be made into custom form

narrs e O

Wiew [ rhemsiens [ o tas C |

< >

Cancel |_Choose This Form _| I

2. Installing searches

Notes - 1. It is recommended to install the search files ahead of setting up the toolbar reminder
as the toolbar reminder references many of the search files and installing out of order may
trigger an error. 2. If you are updating from an older version — It is recommended to delete
all existing versions of the ‘palliative - ### searches to reduce duplicates being added to your
EMR system.

1. From the Records window, choose Settings > Edit Searches.

Palliative Care Tool User Guide 7
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Settings Patient View Data Letter B ]';r
! Edit Stamps...

Edit Custom Forms...
Edit Searches...
Edit Cohorts...

Edit Reminders...

Edit Reminders of Albus Dumbledore
Mew Cuick Individual Reminder for Albus Dumbledore...

Mew Alert for Albus Dumbledore...

| L] Ctrle 1

a Decrease Text Size Ctrl+L |

2. in the Edit Searches window, from the Edit menu, choose Import Searches.

%" Edit Searches

Edit
Ctrl+C
Paste Ctrl+V
Ctrl+D
Add Search Ctrl+A

Ctrl+Shift+Backspace

Ctrl+T
Edit Report Templates...
Import Searches...

Ctrl+5S
Export All.. Ctrl+Shift+5

Import Search Collection(s)..,  Ctrl+Shift+|

3. Find the file location where you have saved the unzipped Palliative Toolkit files, select all
by “Ctrl + A” or “Apple button + A” so it automatically Select all. Click Choose.

Palliative Care Tool User Guide 8
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% Choose Search File *

Look in: 1. Searches ~ ?‘ ol FF

o

Recent Items

Desktop

Documents

This PC

(I I P

LI AL AL IO A0 L A0 JO A A0 A I

File name: ria-Parkinsons.srx™ "Palliative-Criteria-Parkinsons-HPH.srx™

Metwork :
Files of type: | single Search (.srx), or collection of Searches {istx) Cancel @

3. Setting a Reminder to show the Palliative Toolbar
1. Log in to Practice Solutions and select the Records tab.

% PSSuite® EMR (TEST) - X
File Settings Reports Messages Window Help

Dr. Alan A Vong

Logout | Appointments | Patients Inpatients Clients | Address Book | Handouts Messagesl Records
Dashboard ¥

+ 2

2. Select the Settings tab -> Edit Reminders...

File Edit Style Settings Patient View Data Letter

A Palliative, Ded Edit Stamps...

55 King St. Edit Custom Forms...
Waterioo ON Edit Searches...
Edit Cohorts...
¥ Frofile Edit Reminders...
Palliative Edit Reminders of Demo Palliative
Mental Hea New Quick Individual Reminder for Demo Palliative... I
— New Alert for Demo Palliative... =
[ Ed
m Q Increase Text Size Ctrl+1
Wt:£55 I € Decrease Text Size Ctrl+1
—— — ——

Palliative Care Tool User Guide
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3. Select the File tab -> Import Form(s)...

| % Edit Reminders

Edit
Pasl;? rl+v
Duplicate Ctri+D
Add Reminder Cirl+A
ft+ Backsp
+T
Edit Report Templates..
Import Reminders...
Export Reminders.
Export All. Cirl+Shift+S

Import Reminder Collection(s).. Ctrl+Shift+|
&CE antipsychotic reminder QI p...
Flu Shots:
Folate
HET Screening v

Done

4. Find the file location where you have saved the unzipped Palliative Toolkit files, select

all by clicking on one file and holding Shift and selecting the others in the list. Click

Choose.

% Choose Reminder File

Look in: Reminders

TS

Recent trems

&
g

Desktop

=
Documents

This PC

@ File name: "Palliative Reminder Show Toolbar.srx" "Palliative Reminder.srx"

Network  Files of type: | Single Reminder (.sr), or collection of Reminders (.sb) -

Cancel

5. Search for Palliative Reminder Show Toolbar, then select Custom Form or Stamp and

find the Palliative — Toolbar custom form in the dropdown. Click done.

< Edit Reminders

Edit

Fal Reminder Name: Palliztive Reminder Show Toolbar
Reminders PS Suite Reminder, Is In *Paliiztive Reminder”

Consider Palliative care
Palliatve Reminder

Dalets Line

Indent Ling ->

Comments:
() Shew Intervention as Reminder:
@ Show Custom Form or Stamp:_Palliative - Toolbar

Priority: (@ High (scan doily R
PaTiative Care 18
Paliatve Care Toolbar
[Paliiative Toolbar for Demo

Delete Reminder

[Patient Encounter Tracker - PET

Fatel Chiristopher Nursing Toolbar

x

Add Line

<- Qutdent Line

Palliative Care Tool User Guide

10



(T amplify care

4. Importing Handouts into PSS
1. Log in to Practice Solutions and go to > Handouts

- X

[ Fe—
£
> |

2. Select Edit 2 Import Handout

[ Al L —— leitie .

. Handouts

Import Handout... Ctrl+l

Delete Selected Handout N

g Print Selected Handout  Cirl+P
! al -

1 Close Ctrl+W

AL CUTTVET SAUUT TETTTERaE LT ipaan oy wame

f

AFE rEQ Tasl

Locate the Palliative Toolkit v1.0.0 folder and find the Handouts. Have the Window with the
handouts open and drag each handout into the Handout section (can only drag one at a time).

Click Done.

s
= ACP Conw
3 Documents & ¥ ACP CPRTosl

COPMOnepsgerp
Examples of Toalkit
Oscar Opioid Tool

Tool PEG

& OneDrive
= This PC

& Network

<
selected 112KB

vae:
Deserpron

Comments:

i

Palliative Care Tool User Guide
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User Guide

The “No” pathway for the Palliative Tool

1.

Once everything has been installed, the Palliative toolbar should appear in the patient’s

chart. Click on the button called “Palliative?”

% Dr. Alan A Vong - P55
File Edit Style Settings Patient View Data Letter
¥ Pallia Demao

Discuss ASA therapy
Flu Shot

Needs BP Check
FOBT

Information disclosure
Palliative Reminder

SuggeEst Prenmococcat-immumeatenr done [recorded May 24, 2018]

| Palliative [ Palliative? )

| Mental Health Diabetes Lab Req _
bRS&a*x[ARDH ERARRER P

2. The Surprise Question will prompt as a pop-up and the options: No, Not Sure, Yes and

Cancel will appear. Click No if you are not surprised about your patient.

p s

Would you be surprised if the patient were to die in the
next year?

Yes

Mot Sure

Mo

Cancel

Palliative Care Tool User Guide
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3. A pop-up will appear when the Palliative Performance Scale has not been
completed. The completion of Palliative Performance Scale will determine the
appropriate patient’s phase and resources.

pod

,ﬂ A Palliative Performance Scale form has not been completed
s0 a new form will now open.

Upon completion please click the grey update icon beside the
orange oval in the Palliative tool below to show the
appropriate resources for the patient's phase.

4. Fillin the Palliative Performance Scale (PSS) and click Add to Notes.

% Palliative Performance Scale

File

How do I use this form?

Palliative Performance Scale (PPSv2) version 2

Victoria Hospice

prs 1

Lavel

Cnoos. [ P O l;‘::'m::: O Ful O Mormal (] Ful
Qeos |7 Fa O e ey O Fu O - 0 Fut
Oeox OO Fua [0 el oty it et O Ful [ Normad or reduced O Ful
W7o Rosuces | B &= Fu [ T p—— .
Osow | Roswces | [ Unigsiiostouss week [loccasionsi ssistancanccnssary | (] Mommatormeguess |1 ol
st ] wainy saie | (] Uan | |consiseranie assimarce requres || Mormad o isduced | ”G;‘:w
o ol T CI gl [P e o (SR T
.f:)m [ Jrotaly bad bound | [] Tﬂmw ] Total Gare [ mormal of reduces ] Frm
.(:m\ [ Jratamy bad bound | [] m w O Total Care O m-:'u - O Tm
S S (SR~ (SR 0 "5 |0 “rmae
% Duath

DPPS Score:  T0%

Palliative Care Tool User Guide
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5. Look at the Palliative — Main Form and click the refresh button to update the custom
form. The Palliative — Main Form will pull the latest PSS score.

Before:
Jsep 4, 2025 Palliative - Main Form SCH
Palliative Performance Scale e —- g ¢ ESAS-R  PHQ-9
Palliative SOAP Form BRI SDM
Usage analytics Feedback v1.2 Terms & Conditions Developed by (| amplify ccre

After:

[Jspecial Note Palliative - Main Form SCH

Palliative Performance Scale
Palliative SOAP Form

ESAS-R  PHQ-9

Stable: 70% =
= BPI SDM

View: [ summary [ Flowsheet [J Care Team | Phase(s): current all | rndicators: General Spedific

Stable Phase - 70-100%

Goals of Care/End-of-Life Planning Resources Date
Clinician
(J ACP Conversation Guide

] OH atHome Referral for Palliative Services

CCO Pain & Symptom Management Guidelines

| Serious Illness Conversation Guide

Spiritual Care Screening Tool

OMA Palliative Care Billing Guide

R —

atient/Family
Who Is My Substitute Decision-Maker?

ACP Workbook English

] ACP Workbook French

] 7 things to know about palliative care

] 10 myths about palliative care

Regional *

] Pt/family - Hospice Waterloo Region Client Services

Pt/family - Hospice Wellington Client Services
Clinician - Services in WW Palliative Care Beds

Clinician - WW OH at Home Referral for Palliative Services

- .
Usage analytics  Feedback V1.2 Terms & Conditions Developed by (| amplify care

Palliative Care Tool User Guide 14
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The “Yes” pathway for the Palliative Tool

1. Once everything has been installed, the Palliative toolbar should appear in the patient’s
chart. Click on the button called “Palliative?”

% Dr. Alan & Vong - P55

File Edit Style Settings Patient View Data Letter

W paliia Demo

Discuss ASA therapv
Flu Shot

Needs BP Check
FOBT

Information disclosure
Palliative Reminder

Suggest Premmococcat-immumeaterr done [recorded May 24, 2018]

‘ Palliative [ Palliative? )

‘ Mental Health Diabetes Lab Req _
LRSS+ ABDKFRERER D

2. The Surprise Question will prompt as a pop-up and the options: No, Not Sure, Yes and
cancel will appear. Pick and choose Yes if you are surprised about your patient.

s

Would you be surprised if the patient were to die in the
next year?

Yes

Mot Sure

Mo

Cancel

Palliative Care Tool User Guide 15
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3. A custom form will appear called Palliative — Reassess. The Advance Care Planning
form allows the patient to be reassessed in an appropriate timeframe. Click Finish.

*

% Palliative - Reassess

File

Advance Care Planning

Reassess in:

()6 months ()12 months (@other: month(s)

Additional tools:

Substitute Decision Maker Last done:  Oct 29, 2018

Pallistive Performance Scale  Last done:

Finish |

Discard

4. In the toolbar section, it will display a reminder button and count down till reassessment
is due.

| Palliative [ Palliative: Reassess in 10 month(s) ]

TN

(b B E & ARBODRKEESRSRED B

5. The button will turn yellow when it is time for palliative reassessment. Click the button to
answer the Surprise Question again.

| Palliative Palliative: Reassessment due

EEECOETN

s B E3 & A BRBOK ESaRED® D

Palliative Care Tool User Guide 16
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The “Not Sure” pathway for the Palliative Tool

1.

Once everything has been installed, the Palliative toolbar should appear in the patient’s
chart. Click on the button called “Palliative?”

% Dr. Alan & Vong - P55

File Edit Style Settings Patient View Data Letter

v pallia Demo

Discuss ASA therapy
Flu Shot

Needs BP Check
FOBT

Information disclosure
Palliative Reminder

SuggestPrevmococcat-immuermeaton done [recorded May 24, 2018]

‘ palliative [ Palliative? )

‘ Mental Health Diabetes Lab Req _
DRI 4*XAEDK ERGRED ©

2. The Surprise Question will prompt as a pop-up and the options: No, Not Sure, Yes and

cancel will appear. Click Not Sure if you are not sure about your patient.

>

Would you be surprised if the patient were to die in the
next year?

Yes

Mot Sure

Mo

Cancel

Palliative Care Tool User Guide
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3. A custom form called Palliative — General Indicators will display. Click Yes if there are
general indicators of decline and increasing needs. Click No otherwise.

ek

T —

id| - Sentinel event, e.g. serious fall, bereavement, retirement on medical grounds
- Serum albumin < 25 g/l

( Yes

No

)

Are there general indicators of decline and increasing needs?

) (

“Yes” will insart the Palliative form into the chart

“No” will open the Specific Indicators form

< Palliative - General Indicators X
File
General Indicators of Decline
Tools:
- Advancing disease - unstable, deteriorating complex symptom burden Weight graph
- Decreasing response to treatments, decreasing reversibility palliative Performance Scale
- Choice of no further disease modifying treatment
- General physical decline
- Dedining functional performance status (e.g. Palliative Performance Scale (PPS) <= 60,
reduce ambulation, increasing dependence in most activities of daily living) Latest values:
- Co-morbidity is regarded as the biggest predictive indicator of mortaility and morbidity
- Weight loss - > 10% in past 6 months PPS:
- Repeated unplanned/crisis emergency department visits or hospital admissions Serum albumin: 24 May 16, 2018

4. If Yes is clicked, a Palliative Performance Scale will need to be filled.

|

Victoria Hospice

s0 a new form will now open.

x|

,ﬁ A Palliative Performance Scale form has not been completed

Upon completion please click the grey update icon beside the

arange oval in the Palliative tool below to show the

appropriate resources for the patient's phase.

How do I use this form?

Palliative Performance Scale (PPSv2) version 2

Croo%
‘c'_)m
Onox
Orom

Osos

] Fu

[] Reduces

] Reduces

(] Mainty swLe

] Mairty in Bed

[ Tretaty bod bownd
[ Jrotaiy bed bound
[ Jrotaily bed bound

Death

]

O oag

ojgo|olo|o

0

Normal actvity & work
No evidence of disease

Normal actity & work
Some evidence of disease

Normal activity with Effort
Some evidence of disease

Unable Normal JobWork
Significant disease

Unable hobtryhouse work
Significant disease

Unable o do any work
Extensive disease
Unabie to do most activity
Extensve disease

Unabie 1o do any actwity
Extensive disease
Unabie 1o do any actvity
Extensive disease

Unabie to do any actity
Extonsive discase

[m]
O

Full

[]Occasional assistance necessary

[ ]Considerabie assistance requred

(m}
[m}
O
[m]

Mainly assstance

Total Care

Total Care

O(0|jo|o ojo|o

oojg

Normal m}
Normal ]
Normal of reduced ]
Normal of reduced [m}
Normal of recuced (m}
Normal or recuced (m}
Normal of reduced Im]
Normal of reduced ]
un'::n 0
i

Full or Drowsy
+/- Confusion

Full or Drowsy
+- Confusion
Orowsy or Coma
+- Confusion

5. If No is clicked, a custom form called Palliative — Specific Indicators will display. This
form provides specific indicators to review about patient.

Palliative Care Tool User Guide
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€ Palliative - Specific Indicat
File |

Specific Indicators of Decline

Select one of the following categories to view the corresponding specific indicators.

Main categories:

A. Cancer - rapid or predictable declne B. Organ Failure - efratic decline C. Fraity/Dementia - gradual declne
Sub-categories:

Lung Disease (COPD) Heart Disease (CHF) Liver Disease Neurclogic al Disease

Specific Indicators: Tools:
- Stage 4 or 5 Chronic Kidney Disease (CKD) whose condition is deteriorating Learm mare ... Palliative Performanc e Scale

- Patients choosing the ‘no dialysis' option or discontinuing dialysis (by choice or due to Increasing
frailty, co-morbidities)
- Patients with difficult physical symptoms or psychological symptoms despite optimal tolerated
renal replacement therapy
- Symptomatic Renal Fallure
- Nausea and vomiting, anorexia, pruntus, reduced funcoional status, intractable fluid overload
Problem List:

HTN, COPD

Do they have iti icatars of Decli
[ es ) ( No )
¥ es” will insert the Paliative form into the chart

™o~ will open the Advance Care Planning form

6. Click Yes or No once determining the appropriate next step. “Yes” will insert the
Palliative form into the chart and “No” will open the Advance Care Planning form.

| = Palliative - Specific Indicators

[Fite

|| Specific Indicators of Decline

|| select one of the following categories to view the corresponding specific indicators.

Main categories:

| A. Cancer - rapid or predictable dechine B. Organ Failure -_erratic_deciine C. Frailty/Demantia - gradual decline
Sub-categories:
Lung Disease {COPD) Heart Disease (CHF) Kidney Disease (CKDY) Liver Disease MNeurclogic al Disease
Specific Indicators: Tools:
- Stage 4 or 5 Chronic Kidney Disease (CKD) whose condition is detenorating Learn more ... Palliative Performanc e Scale

- Patients choosing the ‘no dialysis' option or discontinuing dialysis (by choice or due to increasing
frailty, co-morbidities)

- Patients with difficult physical symp or psyc
renal replacement therapy

- Symptomatic Renal Failure

- Nausea and vomiting, anorexia, pruntus, reduced functional status, intractable fluid overload

o despite optimal tolerated

Problem List:

HTN, COPD

Do they have Specific Indicators of Decline?

(s J(_ N )

“es” will insert the Palliative form into the chart

{[ | o™ wil open the Advance Care Planning form

Palliative Care Tool User Guide
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7. If Yes is clicked, a Palliative Performance Scale will need to be filled.

s0 a new form will now open.

X

,ﬂ A Palliative Performance Scale form has not been completed

Upon completion please click the grey update icon beside the

orange oval in the Palliative tool below to show the

appropriate resources for the patient’s phase.

How do I use this form?

Palliative Performance Scale (PPSv2) version 2

(Onoon
lt_)-m
Oson
Oron
Oeo%
Orsom

Qaow

Oaon

O10%

0 F

(1 Recucea
] Reduced
[ ] Mainy Sa/Lie

] Mainiy in Bea

[rotatty bed vownd | [

7o taty bed baund

O 0

ojo|a

[rataily bed bound | ]

Death

Normal actwity & work
No ewdence of disease

Normal actvity & wark
Soma evidence of disease

Normal activity with Effort
Some evidance of disease

Unable Normal Job/MWork
Significant disease

Unable hobtryMouse work
Significant isease

Unable 1o do any work

O Full
[} Full
[m] Ful
(m} Ful

Unable fo do mast actvily
Extensive disease
Unade 1o do any actity
Exiensive discase
Unadie 1o do any activity
Extensive disease

Unable to do any actwity
Extonsive disoase

[m} Total Care
O Total Care
[} Total Care

oojojgo ojo|o

oojg

Norrmal

Normal o reduced

Normal of reduced

Normal of reduced

Normal o reduced

Normal or reduced

Normal or reduced
Minimal 1o
sps

Mou care
only

o0 oo|o

o

oojg

Full or Drowsy

Full or Drowsy
+- Conlusion

Full or Drowsy
+- Conhusion
Drowsy or Coma
+- Contusion

8. If No is clicked, a custom form will appear called Palliative — Reassess. The Advance

Care Planning form allows the patient to be reassessed in an appropriate timeframe.

Click Finish.

Palliative Care Tool User Guide

% Palliative - Reassess

File

Advance Care Planning

()6 months

Reassess in:

()12 months

(@other: month(s)

Additional tools:

Substitute Decision Maker

Paliative Performance Scale

Last done:  Oct 29, 2018

Last done:

Discard

20



(T amplify care

How to use the Palliative — Main Form

What is in the View: panel?

The View: panel will contain the core sections of the Palliative tool, sections with checkboxes
can be unchecked to minimize space. Blue text is clickable and will direct to one of the

following: website, PDF or custom form.

1. Click Flowsheet to view the values that are being tracked throughout time by the

Palliative — Main Form.

Palliative Performance Scale

Stable: 70% o

ESAS-R PHQ-9

Palliative SOAP Form BP] SDM
View: Flowsheet | [] Care Team | Phase(s): Current All | Indicators: General Specific

[ Latest Last Mov3 | Mow? Mow2? | Dec3 Dec10 | Dec21

Value Done 2018 2018 2018 2018 2018 2018
PPS Scone % Dec 1 o
Palistive - SOAP % Dec 10 LK X X x X X
Palignive - ESAS-R
B ] Diec 10 3
" @ PanSe ey Soe 3.5 Ot 13
"B PanlneferanceSoone 0.7 Ot 13
Substitute Dscsion Maker < SDM X Oct 29
< >

2. Click Care Team to view and document current providers on the patient’s care team (the

Other fields can be edited when clicked).

Palliative Performance Scale

Stable: 70% £

Palliative SOAP Form

ESAS-R PHQ-9
BPI SDM

View: Phase(s):

|:| Flowsheet Care Team |

Care Team

Current Al

Other notes:
Dr. Test
519-754- 7645
Test

Physician name:
Phone number:
MNurse Practitioner
MNurse

Other 4:

Palliative Care Tool User Guide
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3. Click Current to view the appropriate phase for the patient (based on the Palliative
Performance Scale).

sep 4, 2025 Palliative - Main Form SCH
Palliative Performance Scale
Stable: 80% o ESASR  PHQ-9

Palliative SOAP Form BPI SDM
View: (isummary ([ Flowshest [J Care Team | Phasa(s):l Current IA\I | Indicators: General Spedific
Stable Phase - 70-100%
Goals of Care/End-of-Life Planning Resources Date

Clinician

[J ACP Conversation Guide

[J OH atHome Referral for Palliative Services

(] C€CO Pain & Symptom Management Guidelines

[J Serious Illness Conversation Guide

(] Spiritual Care Screening Tool

(] OMA Palliative Care Billing Guide

Patient/Family

Who Is My Substitute Decision-Maker?

ACP Workbook English
ACP Workbook French

7 things to know about palliative care

10 myths about palliative care
Regional *

[ Pt/family - Hospice Waterloo Region Client Services

] Pt/family - Hospice Wellington Client Services

] Clinician - Services in WW Palliative Care Beds

cian - WW OH at Home Referral for Palliative Services

] Cli

Usage analytics Feedback vi2 Terms & Conditions Developed by (| amplify care

Under Resources, click on checkboxes to document the resources used with the
patient. It will log the date under Date.

Jsep 4, 2025 Palliative - Main Form SCH
palliative Performance Scale
Stable: 80% 3 ESAS-R - PHQ-9
Palliative SOAP Form BPIL sDM
View: () summary (JFlowsheet (JCare Team | Pphasefs): current all | Indicators: General Sspedific
Stable Phase - 70-100%
Goals of Care/End-of-Life Planning Resources pate
Clinician
@ ACP Conversation Guide Sep 4, 2025
@ OH atHome Referral for Palliative Services Sep 4, 2025

[ CCO Pain & Symptom Management Guidelines

[ serious Illness Conversation Guide

() Spiritual Care Screening Tool

OMA Palliative Care Billing Guide Sep 4, 2025

L

tient/ Family

[ Who Is My Substitute Decision-Maker?

| ACP Workbook English
[ Acp workbook French

[J 7 things to know about palliative care

10 myths about palliative care
Regional *

() Pt/family - Hospice Waterloo Region Client Services
() Pt/family - Hospice Wellington Client Services

() Clinician - Services in WW Palliative Care Beds

() Clinician - WW OH at Home Referral for Palliative Services

Usage analytics  Feedback vi2 Terms & Conditions ~ Developed by (| amplify care

Palliative Care Tool User Guide
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4. Click All to view all the palliative care phases of the patient.

Falliative Performance Scale . stable:70% O ESASR PHQ-S
Pallistive SOAP Form Be1 sOM

View: [ Flowsheet [] Care Team 1 Phase(s): Cument AN | Indicators: General Specific

Goals of Care/ Life 0 Date

[ walk more every weel [ advance care Planning Template Dec 27, 2018
[%] Advance care Planning Wi Dec 27, 2018
[2] Advance Care Planning Brochure Dec 27, 2018

[[] conversation Guides
[[] Referral to wwiHPC &
[[] services in palliative care units
a
[[] caredove W Community Support Services
[] Heaithiine services
[[] Pain & Symptom Guidelines (providers)
[[] Pain & symptom Guidelines (patients/families)

Goals of Care/End-of-Life Planning Resources Date
Copy gosls from previous stage [ Advance care Planning Template Dec 27, 2018

- walk more every week Dec 27, 2018

onversatio
[] Referral to wwinpe @
[] services in palliative care units
[[] caredove ww Community Support Services
[] HealthLine Services
[Jomrc &

[] DNR C Information Bulletin

] cPR Decision Aid (Paticats & Familics)
[[] Hospice Waterloo Programs & Services
] Hospice Wellingtan Programs & Services
[[] Planned Death at Home (EDITH) Referral

5. Click Copy goals from previous stage to copy from a previous stage. The same
Resources can be in different stages and will be documented if selected.

Falliative Performance Scale - o ESAS-R PHQ-9
Palliative SOAP Form BPF1 SDM

View: [] Flowsheet [ ] Care Team | Phase(s): Current | Indicators: General Specific

Goals of Care/End-of-Life Planning Resources Date

- Walk more every week Advance Care Planning Template Dec 27, 2018
[] Advance Care Planning W Dec 27, 2018
Advance Care Planning Brochure Dec 27, 2018

[[] conversation Guides
[] Referral to wwWIHPC O
[[] services in palliative care units
[[] cancer support Centre (Hopesprings)
[[] caredove ww Community Support Services
[[] HealthLine Services.
[] Pain & Symptom Guidelines (providers)

[[] Pain & symp (patients )
Goals of Care /End-of-Life Planning Resources Date
Copy goals from previous stage Advance Care Planning Template Dec 27, 2018
Advance Care Planning WW Dec 27, 2018
Advance Care Planning Brochure Dec 27, 2018

[[] conversation Guides
[[] meferral to wwIHPC ¢
[] services in palliative care units
[[] caredove WW Community Support Services
[] HealthLine Services
Jomrc &

Palliative Care Tool User Guide
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6. Click General to view the Palliative — General Indicators Reference custom form. It
will provide information about the general indicators of decline.

% Palliative - General Indicators Reference X
File
General Indicators of Decline
Tools:
- Advancing disease - unstable, deteriorating complex symptom burden Weight graph
- Decreasing response to treatments, decreasing reversibility palliative Performance Scale
- Choice of no further disease modifying treatment
- General physical decline
- Declining functional performance status (e.g. Palliative Performance Scale (PPS) <= 60,
reduce ambulation, increasing dependence in most activities of daily living) Latest values:
- Co-morbidity is regarded as the biggest predictive indicator of mortaility and morbidity
- Weight loss - > 10% in past 6 months PPS: 70% Dec 21, 2018
- Repeated unplanned/crisis emergency department visits or hospital admissions Serum albumin: 24 May 16, 2018
- Sentinel event, e.g. serious fall, bereavement, retirement on medical grounds
- Serum albumin < 25 g/l
Discard

7. Click Specific to view the Palliative — Specific Indicators of Decline custom form. It
will provide information about the specific indicators of decline.

|«
]
gFile
1
.| Specific Indicators of Decline
¢ , . , . , ,
1 Select one of the following categories to view the corresponding specific indicators.
i Main categories:
1 A. Cancer - rapid or predictable decline B. Organ Failure - erratic decline C. Frailty/Dementia - gradual decline
| Sub-categories:
| Lung Disease (COPD) Heart Disease (CHF) Kidney Disease (CKD) Liver Disease Neurological Disease
Specific Indicators: Tools:
- Stage 4 or 5 Chronic Kidney Disease (CKD) whose condition is deteriorating Learn more ... Palliative Performance Scale
- Patients choosing the "no dialysis' option or discontinuing dialysis (by choice or due to increasing
frailty, co-morbidities)
- Patients with difficult physical symptoms or psychological symptoms despite optimal tolerated
renal replacement therapy
- Symptomatic Renal Failure
- Nausea and vomiting, anorexia, pruritus, reduced functional status, intractable fluid overload
Problem List:
HTN, COPD
Discard

Palliative Care Tool User Guide
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Supporting tools in the Palliative — Main Form

What is the Palliative SOAP form?
1. Click Palliative SOAP Form to view eligible billing codes and document in SOAP notes.

Palliative Performance Emlel ESAS-R PHQ-9
Stable: 70%

Falliative SOAF Form ﬂ BPI SDM

View: [] Flowsheet [ ] Care Team | pPhase(s): Current All | Indicators: General Specific

Stable Phase - 70- 100%

Goals of Care/End-of-Life Planning Resources Date
- Walk more every week D Advance Care Planning Template

[[] Aadvance Care Planning WW

|:| Advance Care Planning Brochure

[] conversation Guides

< Palliative - SOAP x
File
SH
O:
A
P:
Billing:
MNote: Start and stop times must be recorded if being billed
Start time:
Stop time:

[[Jk023 - palliative Care Support (>20 min.)
[Jko15 - Counseling of Relatives (scheduled visit)

Biling Summary for Office Visits
Special Premium Bonus Information

Full Palliative Billing Guide

[Irshow additional codes]

Discard Finish Later Finish

Palliative Care Tool User Guide
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2. Click Show additional codes to view all the common forms attached with billing codes.

% Palliative - SOAP X
File
[ IKO015 - Counseling of Relatives (scheduled visit) ~

Biling Summary for Office Visits
Special Premium Bonus Information
Full Palliative Billing Guide

A show additional codes]]

[[]agas - special Palliative Care Consultation {Office, home, OPD)
[[lc945 - Special Paliiative Care Consultation (Hospital)

[]a901 - House call Assessment (< 20 min.)

[le512 - Palliative Care Case Management

[le511 - Telephone Management of Palliative Care (per call)
[1B998 - Special Visit Premium (7:00 - 24:00)

18997 - Special Visit Premium (24:00 - 7:00)

[1B966 - Special Visit Premium travel fee

Common Forms

[Jk035 - Mandatory Reporting of Medical Condition to Ontario Ministry of Transportation

[[lk038 - LTC application form

[[lko70 - Home care application

[lko55 - Special Diet Application Form v
< >

Discard Finish Later Finish

Other helpful supporting tools in the Palliative — Main Form

1. Click the highlighted box for resources that helps support palliative care.

Palliative Performance Scale ESAS-R PHQ-9

Stable: 70% o

Falliative SOAF Form BRI SDM
View: [] Flowsheet [ ] care Team | Phase(s): Current All | Indicators: General Specific
Stable Phase - 70- 100%

Goals of Care/End-of-Life Planning Resources Date

- Walk more every week D Advance Care Planning Template
[] Aadvance Care Planning WWw
|:| Advance Care Planning Brochure

[ ] conversation Guides

Palliative Care Tool User Guide
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2. Click SDM. This is an example of a resource to use with patients. Fill out the patient’s
substitute decision maker information. Click Add to Notes.

% Substitute Decision Maker - SDM * [

File

Substitute Decision Maker (SDM) Handout I

Patient Name  Demo Palliative
po8 Jan 1, 1945

Date Last Entered in Chart Oct 29, 2018

[[JPatient declined to discuss this with health care provider

[Jratient has not chosen SDM

Substitute Decision Maker

Name

Home Phane #

Cell Phone #

Hierarchy 4. Spouse or partner v

Patient has shared their wishes, values, and beliefs with this SDM as they relate to their future healthcara? [ Jves [ |No

Comments  Test
Q

Supporting Documents
Supporting documents in chart? [ Jves [ No
Comments

Test

Discard Add to Notes

Updating/Changing resources

Resources in the palliative main form are organized by Clinician, Patient/family, and Regional
categories. Resources in the Clinician and Patient/Family categories are more generalized and
applicable to most regions. ltems in the Regional category can be tailored specific to regional
care pathways and resources. If you would like to adjust these resources you can:

*please note you or someone at your site may need to have access and knowledge in custom
form editing. All edits must be done in the custom form editing mode of your EMR.

1. Use the built in instructions to add new resources — instructions can be found when
opening the form in the custom form editor mode

Palliative Care Tool User Guide 27
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Add Your Own Resources Guide
Samples Resources:

Handout: Conversation Guides For each of the sample resources, look
Web Link: Advance Care Planning WW at the " Click Event™ and
"Resource’ properties as a guide to

C':'!'!ﬁg'_' 02 WOLIC CeArr, resnlince

Custom Form: ACP Template

Checkbox(es): These checkboxes have been setup but still need the 'Resource Name'

and "Name' to be configured
B =-- Pre-configured for stable phase
[l <-- Pre-configured for transitional phase
B =-- Pre-configured for end-of-life phase

1. Choose a common " Resource Mame™ for each checkbox. E.g. MyResource
2. For each checkbox, set the "Name™ field in this specific way:

chk + (Resource Mame) + (phase)
e.0. chkMyResources

Pha=e naming: 5 = stable, T = transitional, E = End-of-life

3. The "Ewvent Trigged”™ ewvent should be ~ processCheclk” for each checkbox

Date Field(s): Thase date fields have been setup and only nesd the Name to be configured
=-- Pre-configured for stable phase
=-- Pre-configured for transitional phase

=-- Pre-configured for end-of-life phase

1. For each date field, set the "Name" field in this specific way:

date + (Resource Mame) + (phase)
e.g. dateMyResources

Phase naming: 5 = stable, T = transitional, E = End-of-life

2. Use our pre-built resource library — items in this section can be swapped into applicable
sections of the main form.
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-nurce Library - If you would like to use these resources move them to the appropriate section. You dan always add your custom resources using the instructions above

Hospice Room Pamphlet (Rotary club of Kapuskasing)
Understanding Medical Assistance in Dying (MAID)

FMPE - MAID handout

Choosing Wisely - Serious Iliness Conversation Guide

L
L
||
B Ontario Caregiver Starter Kit
L]
L]

Spiritual Assessment Tool - FICA

Transitional Phase

W Hospice Room Pamphlet (Rotary club of Kapuskasing)
W understanding Medical Assistance in Dying (MAID)

B FMPE - MAID handout

W Ontaric Caregiver Starter Kit

M choosing Wisely - Serious Tliness Conversation Guide
B spiritual Assessment Taal - FICA

End of life phase

Hospice Room Pamphlet (Rotary club of Kapuskasing)
M understanding Medical Assistance in Dying (MAID)
B FMPE - MAID handout
W ontario Caregiver Starter Kit
B Choosing Whsely - Serious Tliness Conversation Guide

B spiritual Assessment Tool - FICA

If you have questions or feedback, please feel free to reach out to EMRtools@amplifycare.com.
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